
[image: Oracle Corporation]




Oracle® Fusion Middleware

Using Oracle Eloqua Cloud Adapter

Release 12.2.1.2.0 

E77866-02

February 2017

Documentation for Oracle Service-Oriented Architecture (SOA) developers that describes how to use the Oracle Eloqua Cloud Adapter.






Oracle Fusion Middleware Using Oracle Eloqua Cloud Adapter, Release 12.2.1.2.0 


E77866-02

Copyright © 2015, 2017, Oracle and/or its affiliates. All rights reserved.

Primary Author: Mark Kennedy


This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.





If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.





This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.





Oracle and Java are registered trademarks of Oracle
and/or its affiliates. Other names may be trademarks of their respective
owners.

Intel and Intel Xeon are trademarks or registered
trademarks of Intel Corporation. All SPARC trademarks are used under
license and are trademarks or registered trademarks of SPARC International,
Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks
or registered trademarks of Advanced Micro Devices. UNIX is a registered
trademark of The Open Group.





This software or hardware and documentation may provide access to or information about content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth in an applicable agreement between you and Oracle.





Contents

Preface

	Audience
	Related Resources
	Conventions


1 Introduction to Oracle Eloqua Cloud Adapter

	Oracle Eloqua Cloud
	Installing the Cloud Adapters
	Performing Postinstallation Configuration Tasks
	Disabling Hostname Verification
	Obtaining the Authentication Credentials
	Unsupported Features


2 Understanding Oracle Eloqua Cloud Adapter Features

	Designing an Integration with the Adapter Configuration Wizard
	Monitoring Your Application During Runtime


3 Designing SOA Composite Applications

	Creating a SOA Composite Application
	Adding an Adapter to a SOA Composite Application as a Reference
	Completing Design of a SOA Composite Application


4 Designing Oracle Service Bus Business Services

	Creating an Oracle Service Bus Business Service
	Adding an Adapter to a Business Service as a Reference
	Completing Design of an Oracle Service Bus Business Service


5 Configuring Oracle Eloqua Cloud Properties

	Configuring Basic Information Properties
	What You Can Do from the Basic Info Page
	What You See on the Basic Info Page



	Configuring Oracle Cloud Adapter Connection and CSF Key Properties
	What You Can Do from the Oracle Cloud Adapter Connection Page
	What You See on the Oracle Cloud Adapter Connection Page
	What You Can Do from the Oracle Cloud Adapter CSF Key Page
	What You See on the Oracle Cloud Adapter CSF Key Page



	Configuring Oracle Eloqua Cloud Target Operation Properties
	What You Can Do from the Oracle Eloqua Cloud Target Operations Page
	What You See on the Oracle Eloqua Cloud Invoke Operations Page



	Reviewing Configuration Values on the Summary Page
	What You Can Do from the Summary Page
	What You See on the Summary Page





6 Managing Applications

	Managing the Application in Oracle Enterprise Manager Fusion Middleware Control
	Testing Oracle Service Bus Business Services from Oracle Service Bus Console
	Verifying Results from the Oracle Eloqua Console


7 Troubleshooting and Error Handling

	Test Connection Failure or Wizard Operation Page Does Not Open
	Verifying Installation of the Cloud Adapter in Oracle JDeveloper





Preface

Topics:
Using Oracle Eloqua Cloud Adapter describes how to use the Oracle Eloqua Cloud adapter in your SOA composite applications and Oracle Service Bus business services.




	Audience


	Related Resources


	Conventions






Audience

Using Oracle Eloqua Cloud Adapter is intended for users who want to create, deploy, test, and monitor applications that use the Oracle Eloqua Cloud adapter.





Related Resources

For more information, see these Oracle resources:

	Developing SOA Applications with Oracle SOA Suite


	Administering Oracle SOA Suite and Oracle Business Process Management Suite


	Administering Oracle Service Bus


	Understanding Technology Adapters








Conventions

The following text conventions are used in this document:


	Convention	Meaning
	boldface

	Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.


	italic

	Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.


	monospace

	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.














1 Introduction to Oracle Eloqua Cloud Adapter

This section introduces Oracle Eloqua Cloud adapter. 

Topics
	Oracle Eloqua Cloud


	Installing the Cloud Adapters


	Performing Postinstallation Configuration Tasks


	Disabling Hostname Verification


	Obtaining the Authentication Credentials


	Unsupported Features


	Designing an Integration with the Adapter Configuration Wizard











Oracle Eloqua Cloud

The Oracle Eloqua Cloud adapter enables you to create an integration with an Oracle Eloqua Cloud application. 

Oracle Eloqua Cloud provides cloud-based marketing software that delivers marketing automation for industries such as finance, health, media, real estate, sports, entertainment, and so on. Oracle Eloqua Cloud simplifies marketing procedures by delivering leads targeted to new customers. Oracle Eloqua Cloud helps manage and organize marketing segmentation and marketing workflow.

The Oracle Eloqua Cloud adapter accelerates integrations between customer relationship management (CRM) and Oracle Eloqua Cloud systems. The Oracle Eloqua Cloud connection addresses the synchronization of account and contact data from CRM to Oracle Eloqua Cloud systems.

For more information, see Configuring Oracle Eloqua Cloud Properties.





Installing the Cloud Adapters

This section describes cloud adapter installation details. 

See the README.txt file available with the patch for instructions on installing the cloud adapters. 

After you complete adapter installation, perform the tasks described in Performing Postinstallation Configuration Tasks.

Note:
For information about supported versions and platforms, see the release certification matrix at Supported System Configurations.








Performing Postinstallation Configuration Tasks

You must perform postinstallation configuration tasks after installing the cloud adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud Adapters Postinstallation Configuration Guide.








Disabling Hostname Verification

By default, the WebLogic Server Configuration Wizard sets Hostname Verification to Bea Hostname Verifier when creating the Oracle SOA Suite and Oracle Service Bus domains. Hostname Verification  must be set to None for the Oracle Eloqua Cloud adapter to work.

To disable hostname verification.


	Log in to the Oracle WebLogic Server Administration Console.
	Under Domain  > Environment  > Servers, double-click the server name.
	Click the SSL tab.
	Under Advanced, update Hostname Verification to None.
	Save the change.Note:
If the domain has one administration server and one managed server, both servers must have Hostname Verification set to None.









Obtaining the Authentication Credentials

Obtain the user name and password that are required for creating the Credential Store Framework (CSF) authentication key in Oracle JDeveloper from your SOA domain administrator. These credentials are required for most cloud adapters. 





Unsupported Features

The adapter does not support the following features: 

	Adapter runtime retry configuration properties such as jca.retry.count, jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval.


	Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion Middleware Control.


	The display of properties in the Properties tab for a reference (outbound) adapter in Oracle Enterprise Manager Fusion Middleware Control (for example, service WSDL URL, CSF key used, and others). These are the reference adapters that you select on the Services and References page.


	Rejected message handling


	Metrics such as the number of invocations.


	The following message encryption and decryption features available when you right-click a cloud adapter in the Exposed Service swimlane or External References swimlane in Oracle JDeveloper:

	Protect Sensitive Data > Encrypt Request Data for cloud adapters in the Exposed Service swimlane.


	Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the External References swimlane.





	The policy attachments feature available when you right-click a cloud adapter in the Exposed Service swimlane or External References swimlane in Oracle JDeveloper.










2 Understanding Oracle Eloqua Cloud Adapter Features

The Oracle Eloqua Cloud adapter provides the following features.

Topics
	Designing an Integration with the Adapter Configuration Wizard


	Monitoring Your Application During Runtime











Designing an Integration with the Adapter Configuration Wizard

You use the Adapter Configuration Wizard to add the Oracle Eloqua Cloud adapter to a SOA composite application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to select the artifacts required to communicate with the Oracle Eloqua Cloud application. You can configure the adapter in the outbound (target) direction. 

	The Basic Info page prompts you to enter a meaningful name and optional description. 


	The Connection page prompts you to specify the security policy and authentication key to use. The authentication key is created by clicking the Add icon to specify the key name, Eloqua company name, user name, and password. You must also specify these same values in Oracle Enterprise Manager Fusion Middleware Control. For instructions, see the Oracle Cloud Adapters Postinstallation Configuration Guide.


	The Operations page prompts you to select the accounts, contacts or custom business object and select the field the Oracle Eloqua Cloud adapter uses to match your data to its data. Choose a unique field to avoid updating the wrong record. To avoid errors, do not use a large text field. All fields in the Available section are selected by default. You cannot select only some of them.


	The Summary page displays your selections for the outbound direction.




For information about the details to specify in the fields of the wizard pages, see Configuring Oracle Eloqua Cloud Connection Properties.








Monitoring Your Application During Runtime

This section describes the design time and runtime aspects of using the adapter.

 You use the runtime part of the adapter for delivering the information generated during design time to the service endpoint. You can monitor your SOA composite application or Oracle Service Bus business service from Oracle Enterprise Manager Fusion Middleware Control. You can also test your Oracle Service Bus business service from Oracle Service Bus Console.








3 Designing SOA Composite Applications

This section describes how to design a SOA composite application with the Oracle Eloqua Cloud adapter.

Topics
	Creating a SOA Composite Application


	Adding an Adapter to a SOA Composite Application as a Reference


	Completing Design of a SOA Composite Application











Creating a SOA Composite Application

This section provides an overview of how to create a SOA composite application in which to include the adapter as an exposed service or external reference.

	Start Oracle JDeveloper.
	From the File menu, select New > Application.
	In the New Gallery dialog, select SOA Application from the Items list, then click OK. The SOA Create SOA Application wizard is displayed.
	Specify an application name, and click Next.
	Specify a project name, and click Next.
	Select Composite with BPEL Process, and click Finish.The SOA composite application is displayed for designing in the SOA Composite Editor.







Adding an Adapter to a SOA Composite Application as a Reference

You can add an Oracle Eloqua Cloud adapter to a SOA composite application as an outbound (target) reference to the External References swimlane in Oracle JDeveloper.

	Go to the Component Palette in your SOA composite application.
	Go to the Cloud section under Custom/Third Party.The adapters are displayed. 




	To create an outbound (target) reference, drag the adapter to the External References swimlane, and see the following sections that describe the wizard pages for configuring the adapter.	Configuring Basic Information Properties


	Configuring Oracle Cloud Adapter Connection and CSF Key Properties


	Configuring Oracle Eloqua Cloud Target Operations Properties


	Reviewing Configuration Values on the Summary Page












Completing Design of a SOA Composite Application

This section provides an overview of how to complete design of your SOA composite application and deploy the application.

	Design the remaining contents of your SOA composite application. For example:	Connect the BPEL process to the adapter. For this example, the BPEL process is connected to the adapter as an external reference:


	Design the contents of the BPEL process. For example:	Double-click the BPEL process.


	Add and configure an invoke activity to invoke the adapter.


	Add and configure assign activities to copy the contents of one variable to another when sending and receiving messages to and from the adapter.


	Add and configure other activities, as appropriate.

When complete, view the SOA composite application in the SOA Composite Editor.










For specific information about creating and designing SOA composite applications, see Developing SOA Applications with Oracle SOA Suite.

	Deploy the SOA composite application:	In the navigator, right-click the project and select Deploy > project_name.
	Follow the steps in the deployment wizard to deploy the SOA composite application to the application server.









4 Designing Oracle Service Bus Business Services

This section describes how to design an Oracle Service Bus business service with the adapter in Oracle JDeveloper.

Topics
	Creating an Oracle Service Bus Business Service


	Adding an Adapter to a Business Service as a Reference


	Completing Design of an Oracle Service Bus Business Service











Creating an Oracle Service Bus Business Service

This section provides an overview of how to create an Oracle Service Bus business service in which to include the adapter in Oracle JDeveloper.

	Start Oracle JDeveloper.
	From the File menu, select New > Application.
	In the New Gallery dialog, select Service Bus Application from the Items list, then click OK.
	Specify an application name, and click Next.
	Specify a project name.
	Select Service Bus, and click Finish.The Oracle Service Bus business service is displayed for designing in the Oracle Service Bus Overview Editor. 







Adding an Adapter to a Business Service as a Reference

You can add the adapter to an Oracle Service Bus business service as an outbound (target) external service to the External Services swimlane in Oracle JDeveloper.

	Go to the Component Palette in your Oracle Service Bus business service.
	Go to the Cloud section under Service Bus.The adapters are displayed. 

	To create an outbound (target) external service, drag the adapter to the External Services swimlane, and see the following sections that describe the wizard pages for configuring the adapter:	Configuring Basic Information Properties


	Configuring Oracle Cloud Adapter Connection and CSF Key Properties


	Configuring Oracle Eloqua Cloud Target Operations Properties


	Reviewing Configuration Values on the Summary Page












Completing Design of an Oracle Service Bus Business Service

This section provides an overview of how to complete design of your Oracle Service Bus business service and deploy the application.

	Design the contents of your Oracle Service Bus business service. For example, to configure an Oracle Service Bus proxy service in your business service:	In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins lane and select Insert > Pipeline.The Create Pipeline Service dialog is displayed.

	Enter a name for the pipeline and select the project location, then click Next
	Select WSDL as the Service Type.
	To the right of the WSDL selection, click the Browse icon to select the WSDL.
	Select Application.
	Expand Resource Chooser and select the WSDL file, then click OK.
	Ensure that Expose as a Proxy Service is selected.
	From the Proxy Transport list, select http, then click Finish.The Pipeline component is displayed in the Oracle Service Bus Overview Editor.

	Connect the external service to the Pipeline component.


For more information about creating and designing an Oracle Service Bus business service, see Developing Services with Oracle Service Bus.

	Open the pipeline that shows the default routing.
	 Verify the service and corresponding operation are displayed in the Routing Properties tab at the bottom of the dialog.The outbound project is ready for deployment.

	Deploy the business service.Note:
You cannot use Oracle JDeveloper to deploy a business service to Oracle SOA Cloud Service.


	Select the project, then select Deploy to Service Bus Server.
	Follow the steps in the deployment wizard.









5 Configuring Oracle Eloqua Cloud Properties

The following sections describe the wizard pages that guide you through configuration of the Oracle Eloqua Cloud adapter as a target in an integration. The Oracle Eloqua Cloud adapter cannot be configured as a source in an integration. 

Topic
	Configuring Basic Information Properties


	Configuring Oracle Cloud Adapter Connection and CSF Key Properties


	Configuring Oracle Eloqua Cloud Target Operation Properties


	Reviewing Configuration Values on the Summary Page




For more information about Oracle Eloqua Cloud, see Oracle Eloqua Cloud.








Configuring Basic Information Properties

You can enter a name and description on the Basic Info page of each source and target adapter in your integration.

Topics
	What You Can Do from the Basic Info Page


	What You See on the Basic Info Page









What You Can Do from the Basic Info Page

You can specify the following values on the Basic Info page. The Basic Info page is the initial wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke (target) area supported by your adapter.

	Specify a meaningful name.
	Specify a description of the responsibilities.






What You See on the Basic Info Page

The following table describes the key information on the Basic Info page.


	Element	Description
	What do you want to call your endpoint?

	Provide a meaningful name so that others can understand the responsibilities of this connection. You can include English alphabetic characters, numbers, underscores, and dashes in the name. You cannot include the following:	Blank spaces (for example, My Inbound Connection)


	Special characters (for example,  #;83& or righ(t)now4)


	Multibyte characters







	What does this endpoint do?

	Enter an optional description of the connection’s responsibilities. For example: This connection receives an inbound request to synchronize account information with the cloud application.

















Configuring Oracle Cloud Adapter Connection and CSF Key Properties

Enter the Oracle Cloud adapter configuration connectivity and Credential Store Framework (CSF) key values for your integration.

Topics
	What You Can Do from the Oracle Cloud Adapter Connection Page


	What You See on the Oracle Cloud Adapter Connection Page


	What You Can Do from the Oracle Cloud Adapter CSF Key Page


	What You See on the Oracle Cloud Adapter CSF Key Page









What You Can Do from the Oracle Cloud Adapter Connection Page

You can specify the following connection values for the Oracle Cloud adapter.

	Specify the WSDL URL for some adapters. If you are configuring the Oracle Eloqua Cloud adapter, no WSDL is required.
	Specify the security policy. 
	Create the authentication key. A key created for one direction (for example, outbound) is also available for selection in the other direction (for example, inbound).






What You See on the Oracle Cloud Adapter Connection Page

The following table describes the key information on the Oracle Cloud adapter Connection page.


	Element	Description
	WSDL URL

	Note: This field is not displayed for the Oracle Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to build integrations specific to your instance. You can also select the WSDL from a file system or another source by choosing the browser icon next to the WSDL URL field. Click File System at the top of the dialog, then browse for the WSDL.


	Security Policy

	Select the security policy appropriate to your environment (for example, USERNAME_PASSWORD_TOKEN). 

	The wizard shows all policies, including those that may not be applicable. To make a correct selection, you must have a knowledge of policies. For example, you cannot select a SAML-based policy because the identity is not propagated.


	The policies you apply to the cloud adapter are unique to the cloud adapter and do not impact other endpoints in the composite.







	Authentication Key

	Select the CSF authentication key.

	Add: Click to create a new authentication key. You must specify the key name, user name, and password. 


	Edit: Click to edit an authentication key.


	Delete: Click to delete an authentication key.





	Test

	Click to validate the authentication key.















What You Can Do from the Oracle Cloud Adapter CSF Key Page

You can specify the following CSF key values for the Oracle Cloud adapter.

	CSF key name
	User name and password
	If you are configuring the Oracle Eloqua Cloud adapter only, you must specify a company name.






What You See on the Oracle Cloud Adapter CSF Key Page

The following table describes the key information on the Oracle Cloud adapter CSF Key page. 


	Element	Description
	CSF Key Name

	Specify the CSF key to enable runtime injection of credentials. The adapter uses the CSF to retrieve the username and password required for authentication with the application (for example, the Oracle Sales Cloud or Oracle ERP application). This key identifies your login credentials during design-time.


	Company Name (Oracle Eloqua Cloud adapter only)

	Note: This field is only displayed for the Oracle Eloqua Cloud adapter. 

Specify the Oracle Eloqua company name.


	Email Account and Role

	Note: This field is only displayed for the Oracle NetSuite Cloud adapter. 

Specify the email account and role.


	User Name

	Enter the user name for connecting to your application (for example, the Oracle Sales Cloud or Oracle ERP application). Your administrator provides you with user credentials.


	Password

	Enter the password for connecting to your application.


	Re-enter Password

	Re-enter the same password a second time.

















Configuring Oracle Eloqua Cloud Target Operation Properties

Enter the Oracle Eloqua Cloud target operation values for your integration.

Topics
	What You Can Do from the Oracle Eloqua Cloud Target Operations Tab


	What You See on the Oracle Eloqua Cloud Target Operations Tab









What You Can Do from the Oracle Eloqua Cloud Target Operations Page

You can specify the following target operation values for the Oracle Eloqua Cloud:

	Select business objects (accounts, contacts, or custom objects). The list of available custom objects depends on what is configured in the Oracle Eloqua Cloud application for the user.
	Select the unique identifier field. 






What You See on the Oracle Eloqua Cloud Invoke Operations Page

The following table describes the key information on the Oracle Eloqua Cloud invoke Operations page.


	Element	Description
	Cloud Operation

	Displays the operation to perform. The currently supported operation is import. This means that the Oracle Eloqua invoke imports data into the connected Oracle Eloqua Cloud application. 


	Business Object Type

	Select the business object for the Oracle Eloqua invoke to import into the Oracle Eloqua Cloud application. This enables you to synchronize the business object data from a source system (such as Oracle RightNow Cloud or Oracle Sales Cloud) to the targeted Oracle Eloqua Cloud application.

	Accounts


	Contacts


	Other custom objects associated with the configured Oracle Eloqua Cloud connection





	Select Fields

	 Select the fields of the business object that you want to send to the Oracle Eloqua Cloud application as part of the import operation.


	Uniquely Match on Field

	Select the field that the Oracle Eloqua Cloud application uses to match your data to the existing data in the Oracle Eloqua application. Select a field that is likely to be unique to avoid updating the wrong record. 

Do not use a large text field because this can potentially produce errors.


	Auto-Synch Time Interval

	Select the time interval between data synchronizations. The Oracle Eloqua Cloud connection uses this interval to synchronize data with the Oracle Eloqua Cloud application.

















Reviewing Configuration Values on the Summary Page

You can review the specified adapter configuration values on the Summary page.

Topics
	What You Can Do from the Summary Page


	What You See on the Summary Page









What You Can Do from the Summary Page

You can review source or target configuration details from the Summary page. The Summary page is the final wizard page for each adapter after you have completed your configuration.

	View the configuration details you defined for the source or target adapter. For example, if you have defined an inbound source adapter with a request business object and immediate response business object, specific details about this configuration are displayed on the Summary page.
	Click Done if you want to save your configuration details.
	Click a specific tab in the left panel or click Back to access a specific page to update your configuration definitions.
	Click Cancel to cancel your configuration details.






What You See on the Summary Page

The following table describes the key information on the Summary page.


	Element	Description
	Summary

	Displays a summary of the source or target configuration values you defined on previous pages of the wizard. 

For adapters for which a generated XSD file is provided, click the XSD link to view a read-only version of the file.

To return to a previous page to update any values, click the appropriate tab in the left panel or click Back.

















6 Managing Applications

This section describes how to monitor an Oracle SOA Suite or Oracle Service Bus application that uses the adapter from Oracle Enterprise Manager Fusion Middleware Control or Oracle Service Bus Console and how to verify results in the Oracle Eloqua Console.

Topics
	Managing the Application in Oracle Enterprise Manager Fusion Middleware Control


	Testing Oracle Service Bus Projects from Oracle Service Bus Console


	Verifying Results from the Oracle Eloqua Console











Managing the Application in Oracle Enterprise Manager Fusion Middleware Control

You manage the SOA composite application or Oracle Service Bus business service that includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

	Log in to Oracle Enterprise Manager Fusion Middleware Control.
	In the navigator, expand the tree to display your SOA composite application or Oracle Service Bus business service project (for this example, a SOA composite application is selected).
	Select the SOA composite application. 
	Click Test.The Test Web Service page is displayed.

	Complete the fields on the page to initiate a test of your composite.
	Click Test Web Service.Invocation results are displayed.

	Click Launch Flow Trace to view the flow trace of the SOA composite application, including flow details about the adapter.For more information about monitoring applications from Oracle Enterprise Manager Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle Business Process Management Suite and Administering Oracle Service Bus.







Testing Oracle Service Bus Business Services from Oracle Service Bus Console

You can test Oracle Service Bus business service projects from Oracle Service Bus Console.

	Log in to Oracle Service Bus Console.
	In the navigator under All Projects, open the project to test.
	In the navigator, click the business service for that project.
	Click the Launch Test Console (green arrow button) to test the outbound endpoint.This opens a window that displays the proxy service and the operation to test.

	Provide the input and click Execute. This sends the payload to the Oracle Cloud application. The response is displayed under the Response Document section.
For more information about testing Oracle Service Bus business service projects, see Administering Oracle Service Bus.







Verifying Results from the Oracle Eloqua Console

You can view results of your application from the Oracle Eloqua Console. For this example, an Oracle Eloqua Cloud adapter is defined as an external reference in a SOA composite application. The Oracle Eloqua Cloud adapter inputs an account into the Oracle Eloqua application. When the application is invoked form the Test Web Service page in Oracle Enterprise Manager Fusion Middleware Control, you can view account details in the Oracle Eloqua Console.

	Log in to the Oracle Eloqua Console.https://login.eloqua.com/



	Enter the same company, user name, and password that you entered when specifying the CSF authentication keys in Oracle JDeveloper. 
[image: Description of GUID-A709FCA3-CB18-4F72-874B-312E7CCE0FF3-default.png follows]



	Select Contacts, then select Accounts.
[image: Description of GUID-B90C6C0A-23B4-4068-BF8E-49ED13E40B31-default.png follows]



	Specify the account for which to search, and click the Search icon. For this example, Oracle India-B is specified.Test results are displayed that include Oracle India-B as the Company Name .
[image: Description of GUID-8D1C5899-AF57-4E53-8F26-EE8C5B09D171-default.png follows]










7 Troubleshooting and Error Handling

This section describes how to troubleshoot and handle errors with the adapter. 

Topics
	Test Connection Failure or Operation Page Does Not Open


	Verifying Installation of the Cloud Adapter in Oracle JDeveloper











Test Connection Failure or Wizard Operation Page Does Not Open

If you receive a test connection failure on the Connection page or the Operation page does not display in the Adapter Configuration Wizard, perform the following steps:

	Log in to Eloqua directly and see if the credentials work and the Eloqua application is not down for maintenance.
	The Eloqua user credentials specified must be part of the required security groups and must have required permissions to make Bulk API calls.






Verifying Installation of the Cloud Adapter in Oracle JDeveloper

Follow these steps to verify the installation of the Oracle Cloud adapter in Oracle JDeveloper.

	Open Oracle JDeveloper and check for the presence of the Oracle Cloud adapter in the component palette. Alternatively, you can navigate to the following location:{MIDDLEWARE_HOME}/soa/plugins/jdeveloper/extensions.

	Check for the oracle.cloud.adapter.eloqua.jar file.
	If you are not able to verify the above step, your installation was not successful. Try to install the patch again.
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